
Outlaws
Troubleshooting Guide
This troubleshooting guide has been included on the Outlaws CD to provide you with information about the 
game, and to inform you of solutions to common problems that were encountered during the testing phase.

Table Of Contents
  1. General Troubleshooting

  2. General Information

  3. Installation

  4. DirectX

  5. Alternatives to DirectX

  6. Performance Issues

  7. Video Issues

  8. Sound Issues

  9. CD-ROM Issues

10. Controller Devices

11. Multiplayer Issues

-1- General Troubleshooting

I've installed Outlaws and I can't launch the game.  What do I do now?



· Please check DirectX (Section 4) of this Troubleshooting Guide to see if your computer hardware is 
compatible with DirectX 3.0a.

· If you find that your hardware is not DirectX compatible, you may need to play in a window or try the MGL 
drivers.  For more information on how to do this, please check Alternatives to DirectX (Section 5).

· You may not have enough free space on your hard drive for Outlaws to play.  Check to see how much 
room is left on the drive.  For more information about how free space that you need, please refer to 
Installation (Section 3).

· Do you have any other applications running, such as memory managers, screen savers, or virus protection 
programs?  Any of these may interfere with Outlaws.  Please refer to Performance Issues (Section 6) for 
more information.

· The Outlaws CD may be dirty or scratched, or the CD-ROM drive may be having trouble reading the 
Outlaws CD.  Please check CD-ROM Issues (Section 9).

· You may have moved the folder where you installed Outlaws. You need to uninstall Outlaws and reinstall it 
if you want to change its directory location.

Most Common Error Messages
· Error 80004005 While Locking Front Buffer: You may receive this message if your video card is not 

supported by DirectX. Please see DirectX (Section 4) and Video Issues (Section 7) for more information.
· Error Opening Provider: This error usually means that your network protocol is not properly installed and 

setup. See Multiplayer Issues (Section 11) for more information.
· Error: Could not open line: If you receive this message, exit out of Outlaws completely, and then restart 

the game before trying to reconnect. See Multiplayer Issues (Section 11) for more information.
· Incompatible Level Data: You may see this error if your CD-ROM drive is having trouble reading the data 

on the CD. See CD-ROM Drive Issues (Section 9) for more information.
· Fatal OE in VxD DSound: This error usually occurs when driver for your sound card is not DirectX 

compatible. See Sound Issues (Section 8) and DirectX (Section 4) for more details.
· Required DLL Cannot be Found:  This error occurs when Outlaws does not find DirectX installed on your

computer, or something happens during the installation of DirectX.  Please reinstall DirectX to correct this 
error.  Please see DirectX (Section 4) for more information.

Having Problems?
Outlaws is designed to run under Windows 95 with DirectX 3.0a.  If the game unexpectedly freezes up, returns 
you to your desktop, or if you experience any other severe problems, you should immediately reboot your 
computer.  This will help to prevent possible problems related to the game crash.  It is especially important to 
reboot your computer before trying any of the troubleshooting tips or before attempting to restart the 
game. If this does not correct the problem, we recommend that you completely uninstall Outlaws and then 
reinstall it.

If Your Computer goes to a Black Screen or Locks Up
If you end up at a black screen, please press ESC, SPACE BAR, or ENTER before trying anything else.  
If this fails, press CTRL-ALT-DEL and choose END TASK on Outlaws, which will take you back to the desktop.
Then restart your computer and try running the game again. While playing Outlaws, we suggest that you do 
not use CTRL-ALT-DEL, as this may cause your game to stop responding or freeze up with a looping sound 
playing.

Memory Managers 
If you have memory managers such as EMM386.EXE loading in your CONFIG.SYS file on your hard-drive, you 
may experience problems when running Outlaws. Both Outlaws and Windows 95 are protected mode programs 
and may have problems running with this memory manager loaded.  We do not recommend making any 
changes to your system.  Please consult your computer manufacturer about changing these lines.

Running Programs
Generally, we have found that it is a good idea not to have any other programs running while playing Outlaws. 
Various video, sound, or memory problems may occur while other programs, including screen savers and virus-
detection utilities, are running. Please turn off any active screen savers while playing Outlaws.  If they are active,
they may interrupt the game, which may cause problems to occur.



Adjusting Brightness in the Game
If your screen is too dark, please go to the Options menu and adjust the Gamma.

Scrunched Screen in Windows 95
If you just stopped playing Outlaws and, after you've returned to your Windows 95 desktop, you find that it has 
been scrunched together with no Start Menu in sight, try this:
· Right click on the desktop
· Choose Properties
· Choose Settings
· Change your Color Palette to high color (16-bit) and Desktop Area to 640x480.
· Your computer will then prompt you to restart and everything should be fine.

Changing CDs 
Do not change the discs in the CD-ROM while the game is running unless the game requests the other CD.

Saved Games
Please be sure to specify a name when saving the game.  If you do not give a name for your saved game, 
Outlaws may accidentally save over the previous saved game, or may not save at all.  Please use only letters 
and numbers in your saved game names.  Other characters may cause trouble.

Power Management
If your computer is equipped with a Power Management Feature, you may want to disable it while playing as the
monitor may go to sleep while you are playing.  Please consult your computer's documentation or the 
manufacturer for assistance in doing this.

Icons on Taskbar
Occasionally the icons on your taskbar may turn black.  This is an issue with the way that Windows 95 uses its 
color palette. Outlaws and Windows 95 both use 256 colors.

Computer and Software Compatibility Issues
IBM Aptiva Model #2144M51
We experienced difficulties when testing Outlaws on this computer. We have found one or more pieces of the 
default system hardware are not DirectX compatible.  You may want to contact IBM for more information, or to 
see if they have released updated drivers that will allow your system to be compatible with DirectX.  It has been 
found that on other models of this computer that task-switching when using the MGL drivers may cause the 
computer to crash.

Microsoft Office™
If you are using Microsoft Office™ and are using their Toolbar, we recommend that you turn it off while playing 
Outlaws.  When you restart your computer it will be turned on again. This also applies to any other programs 
that use a toolbar that stays on your desktop.

NEC Ready 9022
The Alliance ProMotion 6422 video card is not DirectX certified. You may not be able to run Outlaws using the 
DirectX drivers.  This card does work with the low resolution MGL drivers that are included on the Outlaws CD.  
Please refer to the Video Issues section of this Troubleshooting Guide for instructions on how to install and run 
the MGL drivers.

Packard Bell 
Some new Packard Bell systems are shipping with S3 ViRGE drivers that are not DX3 supported.  If you choose
"S3 ViRGE PCI," you will only get software emulation.  They have new drivers ("S3 Inc. ViRGE PCI") available. 
The version of this driver that is shipped on the machine will not work correctly with DirectX 3.0a. Packard Bell's 
web address is http://www.packardbell.com.  S3's address is http://www.s3.com.

Toshiba Infinia 7130



You may experience loud music volume.  If this happens, first turn all of the volume sliders up in the game. Then
adjust the volume on the speakers to turn down the music.  This should correct the problem.

-2- General Information

Minimum Requirements
Operating System: Windows 95 required.
CPU:  Pentium 60 or faster required.
Memory:  16MB RAM required.
CD-ROM:  2X CD-ROM required. 4X CD-ROM or above recommended.
Graphics Card: SVGA graphics card required
Sound Card: 16-bit sound card required.
Input Device: Keyboard and mouse required.  Joystick and DirectInput™ compatible devices also supported.
DirectX:  CD includes necessary Microsoft™ DirectX™ drivers.
Installation:  Standard Installation (requires 73MB free hard drive space)

Full Installation (requires 131MB free hard drive space)

Multiplayer Requirements
CPU: Pentium 90 or faster recommended for Multiplayer play.  
Local Area Network Play: Supports up to 8 players via IPX or TCP/IP Local Area Network.
Internet Play: Supports up to 4 players via 28.8Kbps or faster connection to the Internet.
Modem-to-Modem Play: Supports 2 players via 14.4Kbps or faster modem.
Direct Serial Play: Supports 2 players via Null Modem Cable.

Operating Systems Supported
To be able to run Outlaws, you must have Windows 95 as your primary operating system.  If you have a 
different OS (such as OS/2 or Windows NT) we cannot guarantee compatibility.

-3- Installation

During the installation, Outlaws will prompt you to install DirectX 3.0a if it is not already installed on your system.
Microsoft's DirectX is an application that will allow Outlaws to have instant access to your system hardware in 
the Windows 95 environment. This will help Outlaws take advantage of advances in video, sound, and network 
capabilities that will be used during multiplayer or single player gaming.  For more information, please consult 
the DirectX section of this Troubleshooting Guide.

Installing Outlaws
· Please check your available hard drive space before choosing your installation size.  If you have too little 

free space on your hard drive after installation, you may be unable to start the game.  Too little space on a 
hard drive could also affect other applications, such as word processors that need room to spool print jobs.

· A standard installation will require 73 MB of free space on your hard drive. A full installation will require 131 
MB of free space. It is also recommended that you have an additional 20MB of free space available for 
optimum performance.

· We highly recommend using the full installation to optimize the performance of the game in high-resolution 
mode or if your processor is slower than a Pentium 120.

· If you specify your own directory, limit the length of your directory name to 20 characters or less in order to 
avoid possible problems when running the game.

· Never minimize the installation screen while the files are being copied to your hard drive.  This is known to 
cause the installer to lock-up when it is 99% complete.  This will force you to cancel the installation, and 
restart the process from the beginning.

· We recommend that you do not install Outlaws on a network drive.



Uninstalling Outlaws
To remove Outlaws from your computer: 
· Place the Outlaws CD into the CD-ROM drive.  If you have the "Autoplay" option for Windows 95 active, 

the installation menu will automatically come up on your screen.

If the Outlaws Launcher does not automatically appear:
· Double-click on the "My Computer" icon on your desktop
· Double-click on the icon for your CD-ROM drive. 

Once the game menu appears on your screen
· Click on Uninstall Outlaws.

The Windows 95 Uninstall Shield will guide you through the removal process.

Uninstall Warning
When you uninstall Outlaws, you may receive a warning stating that the uninstaller may not have removed 
everything.  Here are a few reasons why you may see this message:
· You have saved games in the directory.
· You have other LucasArts games on your computer. The "LucasArts" directory will not be removed from 

your computer because the other LucasArts games are stored here.
· You may have added files to the directory.  In this case, the uninstaller will not remove the folder.

Other Installation Issues
What if the game's launcher does not respond after installing? 
· The launcher may not be receiving the data that it needs from the CD-ROM drive.
· Your CD-ROM drive may have stopped responding.
· There may be a conflict in your system.
This also may be due to a scratched or dirty CD.  Please consult the CD-ROM section in this guide for more 
information.

What If I Get Have Slow Gameplay or Get a Black Screen?
If you ever uninstalled Outlaws, make sure that you reinstall DirectX when you reinstall Outlaws. For more 
information, please refer to the DirectX section of this Troubleshooting Guide.

Can I Move the Outlaws Folder after I Install?
If you wish to move Outlaws to a new directory, uninstall first, then reinstall to the new desired location.  Simply 
moving the Outlaws folder may cause Outlaws to stop working.

How do I Enable Text in Outlaws?
If you are unable to get sound working in Outlaws or you have disabled your sound, please hold down the ALT 
key and then press the T key to turn on text while in cutscenes.

Calibrating Your Joystick
We recommend that you calibrate your joystick before playing Outlaws.  You can do this by going to the Joystick
Control Panel in Windows 95.

-4- DirectX

First let's give you a little background on Windows 95 DirectX.  Windows 95 Game SDK, which means Software 
Developers Kit, uses a program known as DirectX which will write directly to your video, sound, and input 
hardware.  This allows games to shoot desperadoes faster and hear their taunts better than ever before.  
Unfortunately, not all hardware is supported by DirectX 3.0a.  



How to Check Your System for DirectX Compatibility.
After you have installed Outlaws and DirectX, to determine whether your hardware is certified:
· Choose Troubleshooting from the game's Launcher menu.
· Click on Reinstall DirectX.
· Click on Install Now.  This will take you to the DirectX Setup screen.
· Look at the lines that describe your hardware.  If they say "Certified," then your drivers are DirectX 

certified and the game should run fine. If they have only the version numbers with nothing after that or a 
blank line, then they are supported, but not yet certified by Microsoft and may have problems.  If they say 
"No hardware support," then your drivers are not supported, and you may experience problems when 
playing the game.

· If you have access to the Internet, you may wish to check the Microsoft Website at 
http://www.microsoft.com for new DirectX drivers for your computer's hardware. You can also check with 
your hardware manufacturer for updated DirectX drivers.

Note:  If the game does not install correctly or you did not install DirectX, the following troubleshooting
option may not work.  If you have installed Outlaws and DirectX, have rebooted your computer, and now 
cannot see the game's Launcher, the following is another way that you may check your hardware's certification:
· Go to the Windows 95 desktop
· Double-click on the "My Computer" icon in the upper left corner (or other name if you have changed it).
· Double-click on the C: drive icon.
· Double-click on the Program Files folder.
· Double-click on the folder titled DirectX.
· Double-click on the Setup folder. 
· Double-click on the DXSetup.exe icon.

At this point, your system will be examined for DirectX compatibility.

DirectX Certification
Look at the lines that describe your hardware.  If they say "Certified" on the right hand side of the window, then 
your drivers are DirectX certified and the game should run fine.  If they have only the version numbers with 
nothing after that or a blank line, then they are supported, but not yet certified by Microsoft and may have 
problems.  If they say "No hardware support," then your drivers are not supported, and you may experience 
problems when playing the game.

If you see "No Hardware Support" listed after any of the components, you will need to update the appropriate 
driver so that your system is fully DirectX certified.  The manufacturer of your system should be able to provide 
you with instructions for updating your drivers, and provide you with more information regarding DirectX 
certification.

If you change the video or sound card in your computer, make sure that you reinstall DirectX so that it can install
the necessary drivers for your new hardware.  To do this:
· Choose Troubleshooting from the game's Launcher menu.
· Click on Reinstall DirectX.
· Click on Install Now.  This will take you to the DirectX Setup screen.
· Click on Reinstall DirectX. This will reinstall DirectX on your computer.
· Click on OK when the installer asks you to reboot your computer.

Note: Some programs that were made for earlier versions of DirectX may not work with this version.

Technical Overview of DirectX
The DirectX platform provides an environment that allows developers to use a standardized format when 
programming a game, thus making it accessible to a wide variety of different hardware configurations.  Prior to 
DirectX, developers were forced to write hardware-specific code (with a specific driver for each different piece of
hardware).  The DirectX platform is an Application Programming Interface (or API) that contains many different 
components.  These include:

DirectPlay: An API designed to enhance multiplayer gaming over various online services as well as the 
Internet.



DirectInput: Provides advanced support for both analog and digital control devices within the Windows 95 
environment.

DirectSound: Provides your sound card with audio drivers that make DirectSound less CPU intensive, which 
helps to enhance normal/high quality sound and music, and allows for optimal performance of 3-
D positional audio.  

DirectDraw: Provides support for 2-D rendering of graphics.

Since DirectX is relatively new in the computer world, we have found that some older systems may contain 
hardware that may not be fully DirectX compatible.  For optimum performance in Outlaws, your system 
must fully support DirectX.  Luckily, many manufacturers are releasing updated drivers.  If you are unsure 
whether or not your system will support DirectX, please contact the manufacturer of your system for further 
information.
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If you are Unable to Get Outlaws Working with DirectX 
If you are unable to get Outlaws working with DirectX, we suggest that you play Outlaws in a window.  To do 
this:
· Choose Select Video Mode from the Launcher Menu.
· Click on Window under Display Driver.
· Click OK or press ENTER to continue.
This will bring up a dialog box suggesting that you set your desktop to 800x600 in High Color.
· Click on Yes to close this dialog box.  This will return you to the launcher.
While playing in a window, setting your desktop to high color (16-bit) will greatly enhance the appearance of the 
game. For information about changing your video resolution, please consult the Video Section of this 
Troubleshooting Guide.

Playing in a Window at 256 Colors
When your desktop color mode is set to 256 colors and you are playing Outlaws in a window, if you press ESC 
to access the in-game menu and click on the desktop, the Outlaws screen will start flashing.  When you 
reactivate the Outlaws window, the flashing will stop. 

Cursor Flickers While Playing in a Window
With certain video cards, your arrow cursor may flicker when you are playing in a window.  This is a limitation of 
how the card reads the cursor being used jointly between an application and Windows 95.

Changing Your Desktop Resolution
Outlaws is designed to perform optimally in High Color (16-bit) color mode.  If you are playing Outlaws in a 
window, you will also want to change your Desktop area to 800x600.  To change your desktop resolution and 
color mode:
· Right-click on the desktop.
· Choose Properties from the pop-down menu.
· Click on the Settings tab.
· Choose High Color (16-bit) under Color Palette
· Move the slide-bar under Desktop area to 800x600.
· Click OK to close this window.
· When your computer prompts you to restart, click on Yes.

If you have tried everything else to get your video working, including playing in a window:
We have included low-resolution MGL drivers on the CD.  To copy them onto your computer: 
· Double click on the My Computer icon.
· Right click on the CD-ROM drive icon and choose Explore.
· Double click on the Support directory.



· Double click on the MGL Directory.
· Go to the View menu and choose Options….
· Click on Show all Files.
· Click on OK to close this dialog box.
· Go to the Edit menu and choose Select All.
· Go back to Edit and choose Copy.
Note:  The following steps will not apply if you did not install to default directory.
· Double click on the C: drive folder. 
· Double click on the Program Files folder.
· Double click on the LucasArts folder.
· Double click on the OL_Demo folder.
· Go to the Edit menu and choose Paste.

Once you have copied the files into the Outlaws directory:
· Go back to the Outlaws launcher.
· Choose Change Video Mode
· Click on MGL under Display Driver.
· Click on 320x200 under Available Modes.
· Click OK to return to the launcher.

Video Corruption in Low Resolution Mode
On certain systems, you may experience video corruption when playing in Low Resolution.  The corruption will 
usually appear as a horizontal line flashing randomly across the screen.

The problem can usually be avoided by turning off the TINTING option.  To do this:
· Press ESC
· Choose Options from the menu.
· Select Other Options.
· Disable Tinting by clicking on check box to deselect this option.  
· Click on Accept to save your changes.

Using ALT-TAB when Playing Outlaws in Low-Resolution 
Some video cards do not correctly restore the desktop resolution to its original state when switching away for the
game.  If this happens you may want to try the MGL drivers that we have included on the CD.
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If you are running Outlaws on a Pentium 60 to 90, here are a few things that will enhance the game's 
performance:

Playing Outlaws in Low Resolution
You may want to play Outlaws in low resolution.  To do this: 
· Go to the Outlaws launcher.
· Click on Change Video Mode.
· Click on 320x200 under Available Modes.
· Click OK to return to the launcher.

Disabling Your Joystick
You may want to disable your joystick.  To do this:
· Press ESC.
· Choose Configure.
· Choose Joystick.
· Click on the checkbox next to Active to deselect this option.
· Click on Accept to save your changes.



Adjusting Your Screen Size
You may want to adjust your screen size in the game:
· For better performance, you can shrink your screen size down by using the +/- keys.

Turning Tinting Off
You may want to turn tinting off.  To do this:
· Press ESC.
· Choose Configure.
· Choose Other Controls.
· Deselect Tinting.
· Click on Accept to return to the previous menu.

Memory Managers 
If you have memory managers such as EMM386.EXE loading in your CONFIG.SYS file on your hard-drive, you 
may experience problems when running Outlaws. Both Outlaws and Windows 95 are protected mode programs 
and may have problems running with this memory manager loaded.  We do not recommend making any 
changes to your system.  Please consult your computer manufacturer about changing these lines.

Running Programs
Generally, we have found that it is a good idea not to have any other programs running while playing Outlaws. 
Various video, sound, or memory problems may occur while other programs, including screen savers and virus-
detection utilities, are running.
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DirectX Compatibility
Consult the DirectX section of this Troubleshooting Guide for information about how to check to see if your video
card is DirectX compatible.  If it is not, check with your hardware manufacturer for updated drivers.

Video Card Support for DirectX
It has been found that if your video card is not supported under DirectX, these video problems may occur:
· DirectX may change your existing video driver to an inappropriate driver.
· Black Screen: Your screen may go black but the sound and music will continue to play. 
· Corrupted Graphics: You might see horizontal or diagonal lines all over the screen.
· Strange Colors: Your screen colors might look strange.
· Slow Graphics: The gameplay may be slow.
· Double Vision: Have you ever worn 3D glasses that didn't work quite right?
· Your game may freeze when exiting Outlaws.

On some video cards such as the Genoa Phantom 64, Diamond Stealth 64 2001, or the Trident 
TGUI9680/TGUI9682, which are DirectX supported, you may see the following in the Options Menu:
· There may be graphic static.
· There may be flickering.
· There may be horizontal lines of graphic corruption.
This does not affect gameplay and we have found no fix for it at this time.

Setting up your monitor
If you experience any video problems or are not able to get all of the resolutions that your video card supports, 
you should make sure that your monitor is set up correctly in the display control panel.
· Right-click on the desktop.
· Choose Properties from the pop-down menu.
· Click on the Settings tab.
· Click on Change Display Type…
· Click on Change… in the Monitor Type section.



· Choose your monitor from the list.
· If the correct monitor is not an option in Show Compatible Devices, click on Show All Devices, scroll 

through the list of manufacturers, click on the correct one, then click on the name of your monitor.

Specific Video Card Issues

DirectX may not certify the video driver when it is set to the video card, but will be certified and will work fine if 
the card is set to its chipset.  To manually set your video card to the correct chipset:
· Right-click anywhere on the desktop.
· Choose Properties from the pop-down menu.
· Click on the Settings tab.
· Click on Change Display Type…
· Click on Change… in the Adapter Type section.
· Choose your original video card from the list.
· If the correct chipset is not an option in Show Compatible Devices, click on Show All Devices, scroll 

through the list of Manufacturers, click on the correct one, then click on the name of your chipset.
· When your computer prompts you to restart, click on Yes.

ATI 3D Pro Turbo PC2TV: We have found that DirectX will change this card to the ATI Graphics Pro Turbo.  
You will need to change your card back to its original driver for Outlaws to run.  See the directions above to 
change your driver. ATI's web address is http://www.atitech.com or http://www.atitech.ca.

ATI 3D Xpression: We have found that DirectX will change this card to the ATI Graphics Pro Turbo.  You will 
need to change your card back to its original driver for Outlaws to run.  See the directions above to change your 
driver. ATI's web address is http://www.atitech.com or http://www.atitech.ca.

ATI 3D Xpression+ PC2TV: We have found that DirectX will change this card to the ATI Graphics Pro Turbo.  
You will need to change your card back to its original driver for Outlaws to run.  See the directions above to 
change your driver. ATI's web address is http://www.atitech.com or http://www.atitech.ca.

Creative Labs 3D Blaster: When your video driver is set to 512x384, your monitor may lose its signal, but the 
game will continue.  Creative is aware of this problem.  There may be a fix for it on their website at this time. 
Creative's web address is http://www.creaf.com.

Diamond Multimedia Edge 3D™: DirectX does not support this card because it does not currently have 
Windows 95 compatible drivers.  You can contact your hardware manufacturer or Diamond Multimedia for 
updated DirectX drivers. Diamond's web address is http://www.diamondmm.com.

Diamond Multimedia Viper: DirectX does not support this card because it does not currently have Windows 95
compatible drivers. You can contact your hardware manufacturer or Diamond Multimedia for updated DirectX 
drivers. Diamond's web address is http://www.diamondmm.com.

Diamond Stealth 64 Video VRAM: Use the Diamond GT driver version 4.02.365. Earlier versions were not 
DirectX compatible. Diamond's web address is http://www.diamondmm.com.

Diamond Multimedia Stealth 3D 2000: Setting the card to its chipset works fine. (S3ViRGE). To change the 
chipset, follow the directions above. 

Early versions of Diamond GT drivers: When installing DirectX applications, a dialog box may appear asking 
if you would like to install a certified DirectX driver.  You should select "No," so that the Diamond GT drivers will 
not be overwritten. If you have already let DirectX change the drivers, follow the directions above to change 
back to the correct drivers.  Version 4.02.365 is available on their website and should be DirectX compatible. 
Diamond's web address is http://www.diamondmm.com.

Number Nine #9GXE64: When you hit ALT-ESC in low resolution, you may go to a black screen with blue 
vertical lines & multicolor dots.  ALT-TAB back to the game and it should work fine. 



Number Nine 9FX Motion 771: The stock drivers are not DirectX 3.0a supported.  Setting the card to its 
chipset works fine (S3 Vision968). To change to the chipset, follow the directions listed above.

Number Nine Imagine 128: The shipped drivers have no DirectX support.  Use Windows 95 drivers, then 
reinstall DirectX 3.0a.  The only problem will be when the desktop is set to 256 and you are playing in low 
resolution the game is not full screen.

Orchid Kelvin EZ: You may experience a low frame rate when playing Outlaws at 640x480. Switching to a 
lower resolution should correct this.

S3 ViRGE: Use the driver that is provided to you by DirectX and not the driver that is shipped with the Virge 
chipset.

STB Powergraph 64: The stock drivers are not DirectX 3.0a supported.  Downloading the updated drivers 
(version 4.02.00.0095) from STB's website should correct this. Their web address is http://www.stb.com.

STB Powergraph 64 Video: Setting the card to its chipset works fine. (S3Trio 64+) To change to the chipset, 
follow the directions listed above.

STB Sprint 32: Setting the card to its chipset works fine. (Trident 9440) To change to the chipset, follow the 
directions listed above.

STB Velocity 64V: The newest downloaded drivers are not DirectX 3.0a supported.  Setting the card to its 
chipset works fine (S3 Vision968). To change to the chipset, follow the directions listed above.
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DirectX compatibility
Consult the DirectX section of this Troubleshooting Guide for information about how to check to see if your 
sound card is DirectX compatible.  If it is not, check with your hardware manufacturer for updated drivers.

No Sound in the Outlaws Launcher
The game's Launcher occasionally will have no sound. When this happens, it usually affects the rest of the 
game. Windows may still be using your sound card from the last application you were running.  Rebooting the 
computer should correct this.

Enabling Text
If you are unable to get sound working in Outlaws or you have disabled your sound, please hold down the ALT 
key and then press the T key to turn on text while in cutscenes.

Note: If the Volume Control or the Media Player are not installed, some of the following instructions will not 
work.  If you want to add either of them, please consult the Windows 95 Helpfile for assistance.  Just type 
Volume Control or Media Player in the index section and follow the directions provided by Windows 95.  

Volume Levels in Outlaws
If you find that the music levels are too loud or too quiet, and are unable to change the volume through the 
Outlaws volume configuration screen, then you may adjust these levels using the Windows Volume Control 
icon.  Use the ALT + TAB keys to go to the desktop, then double-click on the speaker icon in the corner of the 
taskbar.  

Music in the Game
When the music reaches the end of its track, there may be a pause when the music reloads, as the music needs
to switch between music tracks during the game. If you are experiencing pauses in the music, it may be that you
are using a slower CD-ROM drive.



CD Audio
Please make sure that you have the CD audio cable connected correctly between your sound card and CD-
ROM drive to hear all of the music in the game.

Powered or Amplified Speakers
If you have powered speakers and have both line-out and speaker-out jacks on your sound card, try plugging 
your speakers into the line-out jack.  Most sound card's speaker-out jack have an amplified signal and may 
cause static or popping on your amplified speakers.  Switching to your line out jack may greatly improve the 
sound quality.

General Sound Card Troubleshooting
If your sound card is not set up correctly in Windows 95, not 100% DirectX or Windows 95 compatible, or you 
have a resource conflict, these sound problems may occur:
· You may hear static.
· You may hear stuttering, especially as someone starts speaking.
· There may be no sound.
· The sound may drop out.
· You may experience a clicking or crackling sound.
· The game may not run.

Here are a few things to do to get your sound working in Outlaws:
First make sure that your sound card is set up correctly in Windows 95. Then use the Windows 95 Media Player 
to test a sound. To do this:
· Click on the START button on your taskbar.
· Choose Programs.
· Choose Accessories.
· Choose Multimedia.
· Choose Media Player.
· Go to the File menu.
· Choose Open... and choose a sound to test.  Please be sure to choose Files of type:  Sound (*.wav).

Wave Settings
Make sure that the wave setting is turned ON.  To do this:
· Double-click on the Volume Control icon on your taskbar.
· Turn the wave setting ON by de-selecting the MUTE box or turning up the volume in the wave setting. 

Volume Control
If you do not have the Volume Control icon on your taskbar:
· Click on the START button on your taskbar.
· Choose Programs.
· Choose Accessories.
· Choose Multimedia.
· Choose Volume Control.
· Turn the wave setting ON by de-selecting the MUTE box or turning up the volume in the wave setting.

Other Volume Control Programs
Other manufacturers may also have proprietary software that must be set separately from the Windows 95 
Volume Control program. Please see your hardware manuals for more information.

Dirty or Scratched CD
A dirty or scratched CD can cause many sound problems.  Ensure that your CD is clean and free of smudges 
and fingerprints. First try cleaning your CD, wiping it gently with a soft cloth. (Move in smooth strokes from the 
center hub to the outer edge of the CD.)

Specific Sound Cards



Aztech Sound Galaxy Washington 16: You may experience occasional bursts of static while you are playing 
Outlaws. Please download the newest drivers from Aztech.  This may fix the problem. Aztech's web address is 
http://www.aztechca.com.

Creative Labs AWE 64: If you are using driver version 4.33.12, Outlaws may crash as soon as you try to start 
the game with a Fatal OE error in VxD DSound. Driver version 4.33.14 corrects this and is currently available on
Creative Lab's website. Creative's web address is http://www.creaf.com.

Early Ensoniq cards: If the game locks up, you are probably using a driver that is not supported by DirectX. 
Version W95b44 of the driver should correct this problem. Ensoniq's web address is http://www.ensoniq.com.

Gravis PnP: When using the newest downloaded drivers, the game had numerous speedup zones in the 
cutscenes, but gameplay was fine. DirectX setup displays a blank line for the audio driver, which means that the 
driver has not yet gone through DirectX certification. Gravis' web address is http://www.gravis.com.

If you are unable to resolve sound problems through this troubleshooting guide, please contact your 
hardware manufacturer for updated DirectX drivers.

-9- CD-ROM Drive Issues

Your CD-ROM drive is not affected by DirectX, but if you are having problems like slow game play, stuttering 
voices, slow graphics, or the game just slowly stops altogether with a minimum or custom install, your CD-ROM 
may not match the requirements for Outlaws.

Specific CD-ROM Drives
We have found that some CD-ROM drives might not be able to keep up with Outlaws under a minimum or 
custom install.  If you have a Sony 2X™, Mitsumi FX001D™,  Mitsumi FX001DE™, TEAC CD-55A™, TEAC 
CD-50™, Sony CDU33A-1™, SonyCDU-55E™, NEC 3X™, NEC 2Vi™, or Panasonic CR-562B™ double 
speed drives, you may experience problems with Outlaws (sounds stuttering, blue screen errors, slow 
gameplay, etc.).  If this is the case, please call your drive manufacturer, and find out if your CD-ROM drive is 
MPC level 2.

MPC Level-2
Outlaws requires a CD-ROM drive that is MPC level 2 compatible.  The MPC level-2 specification requires a 
CPU-usage of less than 60% to maintain a transfer rate of 300Kbs.  Ideally, an MPC drive should take 
proportionally less CPU (45%).

CD-ROM access error
A blue screen CD-ROM access error might be a symptom of one of these problems:
· Dirty or scratched CD.
· Removal of the CD from the computer while Outlaws was running or paused.
· A CD-ROM drive having trouble reading the disc.
· A CD-ROM drive that is not MPC-2 compatible.

First, check your CD for any dirt, fingerprints, smudges or scratches. To clean your CD, wipe it gently with a soft
cloth. (Move in smooth strokes from the center hub to the outer edge of the CD.) If your CD looks fine, then 
replace it in the drive and see if you have this problem again.  If you are still having problems, you may have a 
bad copy of the disc, a CD-ROM drive that is having trouble running the game, or your CD-ROM is not properly 
installed in Windows 95.

"Incompatible Level Data"
You may see this error if your CD-ROM drive is having trouble reading the data on the CD.   If you receive the 
message, "Incompatible Level Data," you will not be able to join a multiplayer game. 
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Keyboard Issues
Users of compact keyboards, such as those found on laptop systems or those used for ergonomic reasons, may
experience some problems using the default set of keyboard commands. If you are using one of these 
keyboards, you may want to use one of the alternative sets of keyboard commands, or use the custom keyboard
configuration to create a set of keyboard commands that works best with your keyboard.

Some keyboards may have limitations in the game, such as:
· You may be unable to cycle through all of the weapons in your inventory while you are in a crouching 

position.  If you stand up, then crouch again, it should correct this problem.
· You may be unable to use multiple keys at once. 
· Occasionally keys may lock up, especially if held down for a long period of time.

Key Functions
A list of the default key functions is provided in the reference card.  You may change the function of many of 
these keys by using the custom configuration menu.  To access this menu:
· Select Options from the game's menu.
· Select Keyboard.  
· From this screen you will be able to assign new functions to the keys.  Once you have finished, click on the

Accept button to save your changes.
· Make sure that you only assign one function to each of the keys on your keyboard, mouse button, or 

joystick button; doing otherwise may cause problems in the game.

Mouse Issues
We have found through testing that the following may happen when you are playing Outlaws using a mouse:
· You cannot use the mouse as a controller when you are playing Outlaws in a window.
· Your mouse button may lock in firing mode when you have held it down for a prolonged period of time.

Joystick Issues
Each joystick will feature various default functions when used with the game. The functions may differ slightly, 
based on the type of joystick being used.  To view the default functions for your joystick, consult the options 
menu.  To access this menu:
· Select Options from the game's menu.
· Select Joystick.  
· From this screen you will be able to view the current functions of the joystick, and/or change the function of 

the various buttons on your joystick. Once you have finished, click on the Accept button to save your 
changes.

· Make sure that you only assign one function to each of the buttons, and a different direction to each Axis, 
otherwise you may cause problems with the game.

Joystick Calibration    
If you experience any problems when using a joystick, you should make sure that your joystick is properly 
calibrated.  To do this:
· Select Options from the game's menu.
· Select Joystick.  
· Select Calibrate.
· Once you have finished the calibration process, Outlaws will be minimized on your taskbar.  To return to 

the game, click on the Outlaws button on your taskbar.  

Joystick Control
When using certain types of joysticks you may encounter the following control problems:



· If you set your hat switch to be used as your strafe buttons you may encounter problems when pushing the 
joystick all the way forward. The strafe buttons may not work.

· You may not be able to customize all the buttons.
· You may not be able to use the keyboard or mouse at all. In this case you will need to use the joystick for 

all game and menu functions.
· You may encounter poor aiming control.
· You may not be able to get your joystick to go completely to the left, right, top or bottom.
· Your cursor may drift off the screen.
· Your button may get stuck in firing mode.
You may have to re-calibrate your joystick.  Depending on the type of joystick you have, you may need to adjust 
your X and Y axis sliders during calibration to get it to calibrate correctly.  

Configuring Unassigned Buttons
If some of your buttons don't work in Outlaws:
· You may not have assigned them in Joystick Configuration.
· You may not have installed the Windows 95 software for your joystick.  First try the Windows 95 software 

that came with your joystick.  You may also want to contact the manufacturer of your joystick for the newest 
drivers.

If You are Having Trouble with Your Gamepad
You may need to enable it in Joystick Configuration.
· Press ESC.
· Click on Joystick.
· Click on the check box next to Gamepad to select this option.
· Click on Accept to save your changes.

Unplugging Your Joystick
Don't unplug your joystick while playing.  But why would you do that, anyway?  If you wish to disable your 
joystick, there is a check box in the Joystick Configuration Screen to disable your joystick.  Just deselect the 
Active button, then click on Accept to save your changes.

Information on Specific Joysticks

CH Flightstick Pro:
We recommend that you do not use a button for persistent functions such as crouching.

Gravis Grip:
The software for the Grip replaces the Windows 95 joystick calibration utility with its own version.  When this 
happens, Outlaws cannot bring up the calibration screen when you try to access it through the game.

Microsoft Sidewinder 3D Pro
On some computers, the Microsoft Sidewinder 3D Pro may need to be setup as a 2 axis/4 button joystick in the 
Joystick Control Panel. Remember to switch the switch at the base of the stick to the single button.

-11- Multiplayer

Minimum Requirements for Hosting a Game
For Optimal Performance during network play, it is recommended that the game be hosted on a fast 
machine (P120+) with a PCI Network Adapter. Having more than 16MB of RAM in the host also improves
network performance and stability.  We recommend that you do not host a game while playing in low 
resolution.

Settings in Internet Control Panel 



Whenever trying to play or host a TCP/IP game on a LAN, Windows 95 may frequently try to connect to 
the Internet.  In most cases, you can cancel out of the Connect to dialog box and maximize the game to 
continue.  This occurs because the "Connect to the Internet as needed" check box is selected in your Internet 
Control Panel.  If this is enabled on the host, it may cause problems for others joining the game.  If you 
experience this problem, we recommend that you deselect this option. If you are playing an Internet game, it is 
recommended that you connect to the Internet before running Outlaws.

Error Opening Provider
If you receive this error, you probably don't have the network protocol installed.  You must have either an IPX or 
a TCP/IP protocol loaded to play Outlaws over a network.  Please talk to your Network Administrator for 
assistance in setting this up.  

Adding a Network Protocol
If you receive the previous message and you are on your home computer, you can use the Windows 95 help 
files to assist you in setting up TCP/IP.  You will need to have this setup before attempting to log on to the 
Internet.  To do this:
· Go to the Start button on your taskbar.
· Choose Help.
· Click on the Index tab.
· Type in Protocol.
· Double click on Installing.
· Follow the on-screen help to install the TCP/IP Protocol.

Joining Simultaneously
When multiple players attempt to join simultaneously, certain problems may occur. These are:
· Some players may not see other players in the lobby or in the game.
· Not all players names will show up in the in-game frag table.
· Some players' characters may appear to be standing still to other players although movement appears 

normal on that player's computer.
· Rarely, the game may lock up while trying to connect to the host.
This is a known limitation of DirectX 3 and may be addressed in a future version of DirectX. When playing on a
network, it is recommended that you enter the lobby one at a time.

More than one player with the Same Name
If more than one player has the same name, only one of their names will be displayed on the scoresheet at the 
end of the game.

Text Messages
Do not use character signs, such as the percent (%) in your taunts, as these characters are often reserved by 
Windows.  Using these characters in your taunts may cause Outlaws to crash.  

Taunts Appear in Single Player Game
If you are typing in a taunt in a multiplayer game when the game ends, that taunt line may appear across your 
HUD in the next single player that you start.  If this happens, please exit the game and restart your computer to 
correct this.

Game Info Not Found
Sometimes when selecting Get Info from the Join Game screen, you may receive a message stating that the 
game is "Not Found," but you will be connected to the game anyway. This usually happens when the host is 
busy, particularly when there are a large number of players connected to a low-end machine as a host.

If a Player Drops Out or you Lose Your Network Connection
When a player other than the host drops out of the game due to a system crash or loses the network 
connection, it often takes the host 2 to 3 minutes to realize that the player has left the game. This is a known 
limitation of DirectX and may be addressed in a future version of DirectX.



Playing an Internet Game on a LAN
If you are playing an Internet game and two or more of the players happen to be on the same TCP/IP LAN, it is 
strongly recommended that you disconnect from the LAN before playing Outlaws. This is due to a characteristic 
of Windows 95 TCP/IP networking.  Duplicate characters or other anomalies may occur during network play.

Network Connection Lost
Sometimes, though very rarely, when playing an IPX game, the host may crash with the message "Network 
Connection Lost."  This is apparently a problem with DirectX, and may be addressed in future versions.  When 
this occurs, you should reboot your computer before restarting the game.

Cannot See the Host
If you are joining a Internet or network game and do not see the host's game immediately, you may need to hit 
the Rescan button a couple of times to see the game.  This happens most frequently during Internet play. We 
have also found that the host may need to minimize Outlaws while other players are joining.  This will make the 
problem happen less frequently. 

Hosting a Game with a Creative Labs 3D Blaster Video Card
Do not task out when in the lobby of a game you are hosting while using a Creative Labs 3D Blaster as this is 
known to cause problems.

Game Ending While Calibrating Joystick
If you are calibrating your joystick when the game ends, when you return to the Options menu you will be at a 
black screen.  You need to hit Space Bar or Enter to return to the game at which point you will get the Game 
Ended message.

IP Address
When connecting through a TCP/IP LAN, you may be prompted with a dialogue box that says "ENTER THE 
COMPUTER NAME OR IP ADDRESS OF THE SESSION HOST, OR LEAVE BLANK TO SEARCH."  If this 
occurs, click OK to bypass the dialogue box, and you should be able to continue.  When playing on the Internet 
using a TCP/IP connection, you will need to enter a computer name or IP address when prompted.  We have 
found that on some computers, entering the name of the computer hosting a game may cause problems.  We 
suggest using the IP address whenever possible.

Modem issues
Before you attempt to host a modem game, make sure that your phone line is connected to your modem and 
that your modem is setup and operating correctly in Windows 95.  You will also need to have an active ISP 
(Internet Service Provider) account if you are going to play Outlaws on the Internet.

Latency Issues
If your Internet connection experiences excessive latency while playing Outlaws, odd things may occur, such as 
minor inconsistencies between what different players see. This condition will correct itself, usually within a few 
seconds.  If problems continue, you might try disconnecting from your ISP and playing later in the hope that you 
will get a more reliable connection to the Internet.

Error: Could not open line
If you receive a message stating, "Error: Could not open line" while attempting to reconnect via modem, try 
exiting the game completely and restarting Outlaws before connecting again.  This is a known limitation of 
DirectX 3 and may be addressed in a future version of DirectX.  If this does not work, check your modem 
configuration to make sure that it is set up correctly.

Cardinal MVPV34XF 33.6k
Hosting a game on the Cardinal MVPV34XF requires an Initialization String to be entered into the modem 
settings. In the Control Panel, double click on Modem, then click Properties, then click on the Connections 
tab, and click Advanced. In the "Advanced Connection Settings" box, under the heading "Extra Settings," 
Type in the string: &F&C1&D0  or if it still doesn't work: type in: &F&C1&D2.




